
Subject: Re: IDL 7.0 Projects
Posted by Vince Hradil on Wed, 05 Dec 2007 22:48:20 GMT
View Forum Message <> Reply to Message

On Dec 5, 4:42 pm, David Fanning <n...@dfanning.com> wrote:
>  Folks,
> 
>  I've been thinking about IDL projects quite a lot the past
>  couple of days, because I'm trying to write an article that
>  can explain this to someone like me. Obviously, I am having
>  a great deal of difficulty. :-(
> 
>  Here is my latest idea. See what you think of it.
> 
>  First, forget about "projects". (Well, you can't forget
>  about them entirely, since IDL 7 is going to force you
>  to use them.) Of course, I'm talking to the Windows crowd
>  here, but I think the same thing applies to most users.
>  Instead, think about "work". You probably already have
>  your IDL *.pro files organized in some kind of "work"
>  structure.
> 
>  For example, I have a "david" directory, and inside of
>  that I have folders named "coyote", "activecontour",
>  "catalyst", "test", etc. My normal way of working is
>  to work in the "david" directory when I am just
>  fooling around, but if I have a specific task
>  or, heaven forbid, "project", I make a separate folder
>  to contain those programs.
> 
>  What I wanted to do in IDL 7 was duplicate this way of
>  working, but if I create a "david" project, then I can
>  no longer create "coyote" and "catalyst" projects, because
>  these live in the "david" folder, and projects (as far as
>  I can tell) cannot be nested like this.
> 
>  So here is what I've created, that is sort of working for
>  me. I've renamed the Default project "Sandbox" and I let that
>  go into the IDLWorkshop folder. This is now where I do my
>  fooling around. I've renamed my "david" folder "idlwork" and
>  with the exception of moving all the *.pro files out of there
>  and over into my "sandbox" directory, I've left the directory
>  structure alone.
> 
>  So, when I fire the IDL Workspace up, I am looking at the
>  project Sandbox. Now, if someone sends me an e-mail saying
>  that FSC_COLOR is a piece of crap, and here is how you can
>  fix it, I simply create a *new* project named "Coyote" and
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>  I create if from the "coyote" directory in "idlwork". I can
>  make changes to coyote programs there. When I am finished with
>  it, I can just delete the Coyote project (taking care, God knows,
>  NOT to delete the contents of the directory!) and I am back
>  to my Sandbox. I can do this with any "project" I care to work
>  with.
> 
>  This has several advantages. It keeps my Project Explorer
>  from overflowing with projects I'm not the least bit interested
>  in at the moment. It means the Workshop doesn't "Analyze Code"
>  for an hour and a half every morning. And it sort of makes
>  sense to me.
> 
>  Of course, if I forget to delete the project before I exit
>  the IDL Workspace, it just starts up again the next morning
>  with the same configuration I left it in.
> 
>  And, naturally, I do ALL the path manipulation manually
>  because I don't trust ANY software that thinks its smarter
>  than I am. This means my programs can find coyote, and catalyst,
>  and other procedures when they need them, even if they are NOT
>  in the project currently.
> 
>  Does this seem like a workable configuration to anyone?
> 
>  Cheers,
> 
>  David
>  --
>  David Fanning, Ph.D.
>  Fanning Software Consulting, Inc.
>  Coyote's Guide to IDL Programming:http://www.dfanning.com/
>  Sepore ma de ni thui. ("Perhaps thou speakest truth.")

(warning: Duck the incoming monkey wrench...)

How about making separate workspaces for each of your "projects", then
choose those when you start up the Workbench.  Have you tried that?

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Wed, 05 Dec 2007 22:54:29 GMT
View Forum Message <> Reply to Message

Vince Hradil writes:

>  How about making separate workspaces for each of your "projects", then
>  choose those when you start up the Workbench.  Have you tried that?
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Well, I've *thought* about it. I haven't had the
gumption to try it yet. The problem with it, it
seems to me, is that you would have to manually
configure your PATH for each Workspace. That seems
not only like a lot of work, but it seems like *exactly*
the kind of thing that sooner or later is going to leave
you scratching your head and looking for the dog to kick.

What say you?

Cheers,

David
-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: IDL 7.0 Projects
Posted by Vince Hradil on Wed, 05 Dec 2007 23:03:36 GMT
View Forum Message <> Reply to Message

On Dec 5, 4:54 pm, David Fanning <n...@dfanning.com> wrote:
>  The problem with it, it
>  seems to me, is that you would have to manually
>  configure your PATH for each Workspace.

Not if you just check the "update Path" box - then the Path will be
updated when you load the appropriate workspace with the appropriate
project(s).  Or you could just set the same path for all workspaces?
or ...

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Wed, 05 Dec 2007 23:16:05 GMT
View Forum Message <> Reply to Message

Vince Hradil writes:

>  Not if you just check the "update Path" box - then the Path will be
>  updated when you load the appropriate workspace with the appropriate
>  project(s).  

This won't work, because I don't just want the project(s)
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on the path. I want coyote, and astro, and jhuapl, and
markwart, and all the rest of it. And, of course, if I
bring all of *those* into the project I would probably 
be spending a fortune at Starbuck's every morning as
I waited for all the code to be "analyzed".

I think the real solution (and a possible motive, now
that I think about it) is to just open IDL on January
1st and leave it open the whole rest of the year. ;-)

>  Or you could just set the same path for all workspaces?

This is what I see as a lot of work and subject to errors.

Cheers,

David
-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: IDL 7.0 Projects
Posted by Paul Van Delst[1] on Wed, 05 Dec 2007 23:34:26 GMT
View Forum Message <> Reply to Message

David Fanning wrote:

<snip>

>  Does this seem like a workable configuration to anyone?

Not really, no. I have to potentially alter my working copy directory structure (which is 
basically a mirror of my repository organised in a way that is logical to *me*) so the IDL 
workbench works as expected? Isn't it meant to work the other way? This sort of approach 
to adaptability (i.e. people adapt to software, rather than the vice versa) seems a bit 
20th century to me. *I* decide what constitutes a "project", or "subproject", or "nested 
subproject"...etc.. as required by my needs, not the software.

Or, should I lay awake for the day my stovetop tells me how it's going to cook my food for 
me when I wonder aloud in front of it "where are the controls for the burners?" Will it 
gasp in horror and refuse to cook my steak when I request it well-done? :o)

cheers,

paulv
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p.s. still waiting for a 7.0 install.....

Subject: Re: IDL 7.0 Projects
Posted by Vince Hradil on Wed, 05 Dec 2007 23:38:57 GMT
View Forum Message <> Reply to Message

On Dec 5, 5:16 pm, David Fanning <n...@dfanning.com> wrote:
>  Vince Hradil writes:
>>  Not if you just check the "update Path" box - then the Path will be
>>  updated when you load the appropriate workspace with the appropriate
>>  project(s).
> 
>  This won't work, because I don't just want the project(s)
>  on the path. I want coyote, and astro, and jhuapl, and
>  markwart, and all the rest of it. And, of course, if I
>  bring all of *those* into the project I would probably
>  be spending a fortune at Starbuck's every morning as
>  I waited for all the code to be "analyzed".
> 
>  I think the real solution (and a possible motive, now
>  that I think about it) is to just open IDL on January
>  1st and leave it open the whole rest of the year. ;-)
> 
>>  Or you could just set the same path for all workspaces?
> 
>  This is what I see as a lot of work and subject to errors.
> 
>  Cheers,
> 
>  David
>  --
>  David Fanning, Ph.D.
>  Fanning Software Consulting, Inc.
>  Coyote's Guide to IDL Programming:http://www.dfanning.com/
>  Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Sorry, but it seems like you want your cake and it eat, too.

If you open the project and allow IDL to manage the code, it will
"Analyze the code..."
If you set a path including all the subdirectories that you don't want
as projects, it will "Analyze the code..."

I think your January 1st idea is the best, yet, but why wait until the
new year?
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Subject: Re: IDL 7.0 Projects
Posted by JD Smith on Wed, 05 Dec 2007 23:50:19 GMT
View Forum Message <> Reply to Message

On Wed, 05 Dec 2007 16:16:05 -0700, David Fanning wrote:

>  Vince Hradil writes:
>  
>>  [quoted text muted]
>  
>  This won't work, because I don't just want the project(s) on the path. I
>  want coyote, and astro, and jhuapl, and markwart, and all the rest of it.
>  And, of course, if I bring all of *those* into the project I would
>  probably be spending a fortune at Starbuck's every morning as I waited for
>  all the code to be "analyzed".

Is the real point of projects to avoid the overhead of analyzing the
full set of .pro files on your PATH?  What kind of analysis is this?
IDLWAVE's idlwave_catalog perl program catalogs my entire set of
libraries in a couple of seconds.

JD

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Wed, 05 Dec 2007 23:54:25 GMT
View Forum Message <> Reply to Message

Paul van Delst writes:

>  p.s. still waiting for a 7.0 install.....

Well, then you still haven't seen how glowing the future
looks. Maybe you will change your tone to one of respectful
awe when you do. :-)

Cheers,

David

-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Page 6 of 24 ---- Generated from comp.lang.idl-pvwave archive

http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=usrinfo&id=3377
http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=rview&th=25837&goto=57238#msg_57238
http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=post&reply_to=57238
http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=usrinfo&id=4003
http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=rview&th=25837&goto=57241#msg_57241
http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=post&reply_to=57241
http://idlcoyote.com/comp.lang.idl-pvwave/index.php


Subject: Re: IDL 7.0 Projects
Posted by Doug Edmundson on Thu, 06 Dec 2007 00:02:59 GMT
View Forum Message <> Reply to Message

David Fanning wrote:
>  Vince Hradil writes:
>  
>>  How about making separate workspaces for each of your "projects", then
>>  choose those when you start up the Workbench.  Have you tried that?
>  
>  Well, I've *thought* about it. I haven't had the
>  gumption to try it yet. The problem with it, it
>  seems to me, is that you would have to manually
>  configure your PATH for each Workspace. That seems
>  not only like a lot of work, but it seems like *exactly*
>  the kind of thing that sooner or later is going to leave
>  you scratching your head and looking for the dog to kick.
>  
>  What say you?
>  
>  Cheers,
>  
>  David

Hi David and Vince,

I'll just chime in here to make the evil that is multiple workspaces 
more tempting!  ;-)

Actually, it should be fine to have multiple workspaces, but you'll most 
probably want to turn off path management since it does update your path 
*preference*.

Having gotten that out of the way, you can set up shortcuts that launch 
the IDL Workbench with the following argument

	-data <path to workspace>

Just another way to avoid the "pick workspace" dialog.

Cheers,
Doug

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Thu, 06 Dec 2007 00:04:15 GMT
View Forum Message <> Reply to Message
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JD Smith writes:

>  Is the real point of projects to avoid the overhead of analyzing the
>  full set of .pro files on your PATH?  What kind of analysis is this?
>  IDLWAVE's idlwave_catalog perl program catalogs my entire set of
>  libraries in a couple of seconds.

Are you available for consulting?

Cheers,

David
-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: IDL 7.0 Projects
Posted by b_gom on Thu, 06 Dec 2007 00:16:58 GMT
View Forum Message <> Reply to Message

On Dec 5, 4:38 pm, Vince Hradil <hrad...@yahoo.com> wrote:

>  If you open the project and allow IDL to manage the code, it will
>  "Analyze the code..."
>  If you set a path including all the subdirectories that you don't want
>  as projects, it will "Analyze the code..."

My concern is that if your code is on a network server like mine, then
these problems are all compounded; the process takes much longer, and
you also bog down the server.

Subject: Re: IDL 7.0 Projects
Posted by Doug Edmundson on Thu, 06 Dec 2007 00:25:26 GMT
View Forum Message <> Reply to Message

David Fanning wrote:
>  Folks,
>  
>  I've been thinking about IDL projects quite a lot the past 
>  couple of days, because I'm trying to write an article that 
>  can explain this to someone like me. Obviously, I am having
>  a great deal of difficulty. :-(
>  
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>  Here is my latest idea. See what you think of it.
>  
>  First, forget about "projects". (Well, you can't forget
>  about them entirely, since IDL 7 is going to force you
>  to use them.) Of course, I'm talking to the Windows crowd
>  here, but I think the same thing applies to most users.
>  Instead, think about "work". You probably already have
>  your IDL *.pro files organized in some kind of "work"
>  structure.
>  
>  For example, I have a "david" directory, and inside of
>  that I have folders named "coyote", "activecontour",
>  "catalyst", "test", etc. My normal way of working is
>  to work in the "david" directory when I am just 
>  fooling around, but if I have a specific task
>  or, heaven forbid, "project", I make a separate folder
>  to contain those programs.
>  
>  What I wanted to do in IDL 7 was duplicate this way of
>  working, but if I create a "david" project, then I can 
>  no longer create "coyote" and "catalyst" projects, because
>  these live in the "david" folder, and projects (as far as
>  I can tell) cannot be nested like this.
>  
>  So here is what I've created, that is sort of working for
>  me. I've renamed the Default project "Sandbox" and I let that
>  go into the IDLWorkshop folder. This is now where I do my 
>  fooling around. I've renamed my "david" folder "idlwork" and
>  with the exception of moving all the *.pro files out of there
>  and over into my "sandbox" directory, I've left the directory
>  structure alone. 
>  
>  So, when I fire the IDL Workspace up, I am looking at the
>  project Sandbox. Now, if someone sends me an e-mail saying
>  that FSC_COLOR is a piece of crap, and here is how you can
>  fix it, I simply create a *new* project named "Coyote" and
>  I create if from the "coyote" directory in "idlwork". I can 
>  make changes to coyote programs there. When I am finished with
>  it, I can just delete the Coyote project (taking care, God knows,
>  NOT to delete the contents of the directory!) and I am back
>  to my Sandbox. I can do this with any "project" I care to work
>  with. 
>  
>  This has several advantages. It keeps my Project Explorer
>  from overflowing with projects I'm not the least bit interested
>  in at the moment. It means the Workshop doesn't "Analyze Code"
>  for an hour and a half every morning. And it sort of makes 
>  sense to me.
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>  
>  Of course, if I forget to delete the project before I exit
>  the IDL Workspace, it just starts up again the next morning
>  with the same configuration I left it in.
>  
>  And, naturally, I do ALL the path manipulation manually
>  because I don't trust ANY software that thinks its smarter
>  than I am. This means my programs can find coyote, and catalyst,
>  and other procedures when they need them, even if they are NOT
>  in the project currently.
>  
>  Does this seem like a workable configuration to anyone?
>  
>  Cheers,
>  
>  David

David,

This sounds good to me, especially if you have routine name "collisions" 
(due to multiple versions of the same library?) and hence need to pay 
particular attention to path order.  We have similar users here at ITT 
VIS who do that.

The only thing I'd add for anyone else who's reading this is that if 
they don't care about the order of routines on their path, they might 
want to go ahead and trust, yes by golly, trust the IDL Workbench to 
manage their path.  :-)  That way one doesn't have to constantly create 
and destroy projects.  When a project is closed, it'll be automatically 
removed from the path and not parsed (no "analyzing code").  To close a 
project, go to the "Project Explorer" view, right-click on a project and 
choose "Close Project".  Opening a managed project will immediately 
re-add it to the path.

Cheers,
Doug

Subject: Re: IDL 7.0 Projects
Posted by Vince Hradil on Thu, 06 Dec 2007 00:53:30 GMT
View Forum Message <> Reply to Message

On Dec 5, 6:25 pm, Doug Edmundson <do...@ittvis.com> wrote:
>  David Fanning wrote:
>>  Folks,
> 
>>  I've been thinking about IDL projects quite a lot the past
>>  couple of days, because I'm trying to write an article that
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>>  can explain this to someone like me. Obviously, I am having
>>  a great deal of difficulty. :-(
> 
>>  Here is my latest idea. See what you think of it.
> 
>>  First, forget about "projects". (Well, you can't forget
>>  about them entirely, since IDL 7 is going to force you
>>  to use them.) Of course, I'm talking to the Windows crowd
>>  here, but I think the same thing applies to most users.
>>  Instead, think about "work". You probably already have
>>  your IDL *.pro files organized in some kind of "work"
>>  structure.
> 
>>  For example, I have a "david" directory, and inside of
>>  that I have folders named "coyote", "activecontour",
>>  "catalyst", "test", etc. My normal way of working is
>>  to work in the "david" directory when I am just
>>  fooling around, but if I have a specific task
>>  or, heaven forbid, "project", I make a separate folder
>>  to contain those programs.
> 
>>  What I wanted to do in IDL 7 was duplicate this way of
>>  working, but if I create a "david" project, then I can
>>  no longer create "coyote" and "catalyst" projects, because
>>  these live in the "david" folder, and projects (as far as
>>  I can tell) cannot be nested like this.
> 
>>  So here is what I've created, that is sort of working for
>>  me. I've renamed the Default project "Sandbox" and I let that
>>  go into the IDLWorkshop folder. This is now where I do my
>>  fooling around. I've renamed my "david" folder "idlwork" and
>>  with the exception of moving all the *.pro files out of there
>>  and over into my "sandbox" directory, I've left the directory
>>  structure alone.
> 
>>  So, when I fire the IDL Workspace up, I am looking at the
>>  project Sandbox. Now, if someone sends me an e-mail saying
>>  that FSC_COLOR is a piece of crap, and here is how you can
>>  fix it, I simply create a *new* project named "Coyote" and
>>  I create if from the "coyote" directory in "idlwork". I can
>>  make changes to coyote programs there. When I am finished with
>>  it, I can just delete the Coyote project (taking care, God knows,
>>  NOT to delete the contents of the directory!) and I am back
>>  to my Sandbox. I can do this with any "project" I care to work
>>  with.
> 
>>  This has several advantages. It keeps my Project Explorer
>>  from overflowing with projects I'm not the least bit interested
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>>  in at the moment. It means the Workshop doesn't "Analyze Code"
>>  for an hour and a half every morning. And it sort of makes
>>  sense to me.
> 
>>  Of course, if I forget to delete the project before I exit
>>  the IDL Workspace, it just starts up again the next morning
>>  with the same configuration I left it in.
> 
>>  And, naturally, I do ALL the path manipulation manually
>>  because I don't trust ANY software that thinks its smarter
>>  than I am. This means my programs can find coyote, and catalyst,
>>  and other procedures when they need them, even if they are NOT
>>  in the project currently.
> 
>>  Does this seem like a workable configuration to anyone?
> 
>>  Cheers,
> 
>>  David
> 
>  David,
> 
>  This sounds good to me, especially if you have routine name "collisions"
>  (due to multiple versions of the same library?) and hence need to pay
>  particular attention to path order.  We have similar users here at ITT
>  VIS who do that.
> 
>  The only thing I'd add for anyone else who's reading this is that if
>  they don't care about the order of routines on their path, they might
>  want to go ahead and trust, yes by golly, trust the IDL Workbench to
>  manage their path.  :-)  That way one doesn't have to constantly create
>  and destroy projects.  When a project is closed, it'll be automatically
>  removed from the path and not parsed (no "analyzing code").  To close a
>  project, go to the "Project Explorer" view, right-click on a project and
>  choose "Close Project".  Opening a managed project will immediately
>  re-add it to the path.
> 
>  Cheers,
>  Doug

That seems reasonable to me, but I think David is also concerned about
seeing all those projects in the project browser.

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Thu, 06 Dec 2007 01:15:18 GMT
View Forum Message <> Reply to Message
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Vince Hradil writes:

>  That seems reasonable to me, but I think David is also concerned about
>  seeing all those projects in the project browser.

Well, I'd love to get rid of the project browser, actually.
I'd like a little space to, uh, you know, work. :-)

I have this configured so I have an editor, a console,
and a command line. (I am thinking, pessimistically
as it turns out, about how I would use this to teach
an IDL course.) If I want to see the last 4-5 commands
in the console, I can see exactly 16 lines in my editor.
Not really enough to do any useful work. And this with
a smallish font that I'm sure would not project well
in a class or lecture situation.

I *have* figured out how to make the editor or console
window take up the whole space and then shrink down again
into this cramped configuration. That's a nice feature.
But why are tabs and icon bars so damn HUGE? I figure
nearly a sixth of my display is taken up with stuff I'd love
to get rid of. (I used to think the Windows XP look
was bloated.)

Combine this with the fact that I can't get my graphics
windows forward without reaching for my mouse and that I
don't have enough memory on my laptop to run this in a
non-embarrassing way, and I'm pretty sure I won't be running
off to show this to the rest of the world anytime soon.
When did they say 7.1 was due out?

Cheers,

David

-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: IDL 7.0 Projects
Posted by Michael Galloy on Thu, 06 Dec 2007 02:32:45 GMT
View Forum Message <> Reply to Message

On Dec 5, 6:15 pm, David Fanning <n...@dfanning.com> wrote:
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>  Well, I'd love to get rid of the project browser, actually.
>  I'd like a little space to, uh, you know, work. :-)

Interesting. I find the project browser just the thing for me.

>  I have this configured so I have an editor, a console,
>  and a command line. (I am thinking, pessimistically
>  as it turns out, about how I would use this to teach
>  an IDL course.) If I want to see the last 4-5 commands
>  in the console, I can see exactly 16 lines in my editor.
>  Not really enough to do any useful work. And this with
>  a smallish font that I'm sure would not project well
>  in a class or lecture situation.

Yes, I've thought about that problems with presentations. I think I
might create a separate "Presentation" perspective that would have a
minimum of views. Not sure how effective this would really be, though.
It would need to set font sizes too and I don't think that is
possible.

>  I *have* figured out how to make the editor or console
>  window take up the whole space and then shrink down again
>  into this cramped configuration. That's a nice feature.
>  But why are tabs and icon bars so damn HUGE? I figure
>  nearly a sixth of my display is taken up with stuff I'd love
>  to get rid of. (I used to think the Windows XP look
>  was bloated.)

I'm not really sure what you mean. You can resize, temporarily
minimize, or eliminate everything you don't want. Here's a screenshot
of how I set up my workbench:

   http://michaelgalloy.com/wp-content/uploads/2007/12/workbenc h-screenshot.png

I don't see where the extra stuff is.

>  Combine this with the fact that I can't get my graphics
>  windows forward without reaching for my mouse and that I
>  don't have enough memory on my laptop to run this in a
>  non-embarrassing way, and I'm pretty sure I won't be running
>  off to show this to the rest of the world anytime soon.
>  When did they say 7.1 was due out?

I guess that $100 for extra memory was well worth it because it runs
fairly well for me (except the help, I always want to quickly look
something up, but it's never very quick).

I guess this is all predicated on the fact that I only use the
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Workbench for just over 50% or so of my work with IDL. I'm glad I
don't have to use Windows any more...

Mike
--
www.michaelgalloy.com
Tech-X Corporation
Software Developer II

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Thu, 06 Dec 2007 02:48:02 GMT
View Forum Message <> Reply to Message

Mike Galloy writes:

>  Here's a screenshot of how I set up my workbench:
>  
>     http://michaelgalloy.com/wp-content/uploads/2007/12/workbenc h-screenshot.png

Wow, yes, I don't have that kind of real estate on my machine.
What kind of screen resolution is this?

>  I don't see where the extra stuff is.

I have about 8 inches of useable space (vertically)
on my display. A useless status bar at the bottom takes
up 1/2 inch, an icon bar at the top (which you don't have)
takes up 1/2 inch, and each tab (there are three) takes
up 3/8 inch. So, more than 2 of 8 inches is wasted space
on my display. (Might be the KDE window manager, I guess,
although these look like JAVA widgets to me.)

>  I guess that $100 for extra memory was well worth it because it runs
>  fairly well for me (except the help, I always want to quickly look
>  something up, but it's never very quick).

I looked into memory, but my machine (admittedly an old one,
relatively speaking, but not as old as the puppy) is memory
limited at 512 MBytes.

>  I guess this is all predicated on the fact that I only use the
>  Workbench for just over 50% or so of my work with IDL. I'm glad I
>  don't have to use Windows any more...

Well, I'm still using IDL 6.4 if I have any real work to do. :-)

Cheers,
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David
-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: IDL 7.0 Projects
Posted by Vince Hradil on Thu, 06 Dec 2007 03:08:21 GMT
View Forum Message <> Reply to Message

On Dec 5, 8:32 pm, "mgal...@gmail.com" <mgal...@gmail.com> wrote:

>  I guess that $100 for extra memory was well worth it because it runs
>  fairly well for me (except the help, I always want to quickly look
>  something up, but it's never very quick).
> 

That's what the "infopops" are for  (just float the mouse over
something and it pops up).  And control+space for completion.

Also, font sizes for the title tabs can be changed, but it doesn't
change the size of the Tabs themselves.  David, maybe you can group
your tabs together in a single view so that they only take up one
line?  Also, you can set some views as "fast views" by clicking on the
icon in the bottom left of the gui - then you get these hidden views
on the status bar the you can pop up and pop down quickly.  I think
this would be nice for, say, Variables or Command History - they are
nice to look at every now and then, but I don't want them take up my
real estate.  In fact, you can make the Project Explorer a "fast view"
too.

Like this: http://tinyurl.com/2dw7bk

Subject: Re: IDL 7.0 Projects
Posted by Michael Galloy on Thu, 06 Dec 2007 03:20:55 GMT
View Forum Message <> Reply to Message

On Dec 5, 7:48 pm, David Fanning <n...@dfanning.com> wrote:
>  Mike Galloy writes:
>>  Here's a screenshot of how I set up my workbench:
> 
>>    http://michaelgalloy.com/wp-content/uploads/2007/12/workbenc h-screens...
> 
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>  Wow, yes, I don't have that kind of real estate on my machine.
>  What kind of screen resolution is this?

15" laptop: 1440 by 900.

>>  I don't see where the extra stuff is.
> 
>  I have about 8 inches of useable space (vertically)
>  on my display. A useless status bar at the bottom takes
>  up 1/2 inch, an icon bar at the top (which you don't have)
>  takes up 1/2 inch, and each tab (there are three) takes
>  up 3/8 inch. So, more than 2 of 8 inches is wasted space
>  on my display. (Might be the KDE window manager, I guess,
>  although these look like JAVA widgets to me.)

Wow. I removed the icon bar since it didn't seem to offer much (I
always stay in debug mode and I use keyboard shortcuts for all the
toolbar buttons). I would consider removing the status bar if I could
figure out how.

>>  I guess that $100 for extra memory was well worth it because it runs
>>  fairly well for me (except the help, I always want to quickly look
>>  something up, but it's never very quick).
> 
>  I looked into memory, but my machine (admittedly an old one,
>  relatively speaking, but not as old as the puppy) is memory
>  limited at 512 MBytes.

Memory is well worth the money unless you're planning on ditching that
machine.

>>  I guess this is all predicated on the fact that I only use the
>>  Workbench for just over 50% or so of my work with IDL. I'm glad I
>>  don't have to use Windows any more...
> 
>  Well, I'm still using IDL 6.4 if I have any real work to do. :-)

I understand.

Mike
--
www.michaelgalloy.com
Tech-X Corporation
Software Developer II

Subject: Re: IDL 7.0 Projects
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Posted by Spon on Thu, 06 Dec 2007 13:19:28 GMT
View Forum Message <> Reply to Message

On Dec 6, 2:32 am, "mgal...@gmail.com" <mgal...@gmail.com> wrote:
>  ...fairly well for me (except the help, I always want to quickly look
>  something up, but it's never very quick).
> 
>  Mike
>  --www.michaelgalloy.com
>  Tech-X Corporation
>  Software Developer II

This is the one thing that's causing me problems with 7.0. As a newbie
I need the help menu a _lot_, and as far as I can tell the reason it's
so much slower to start on v7 than v6.4 is because it defaults to
opening the 'search' tab, where v6 help started in the 'Index' tab. I
_like_ that index tab; usually I know the title of the helpfile I'm
looking for (probably because I've spent so much of the past half year
staring at IDL help files :-) ) so I don't need to go to 'search'
every time. And when I do (in the IDL6.4 help window), yes, it takes
its time, but I don't mind because I'll only click that tab when I
really need it.

Is there any way to make v7.0 help start in this way? I can see the
index tab lurking right there at the bottom, so it hasn't just
disappeared.
I guess it's no big issue really as I usually fire up IDL help before
I start IDL (if I do it this way 'round the helpfile Doesn't Close
when I exit IDL - or crash it again!) This means I can continue to use
the helpfile for version 6 until I find out how to fix this.

Apart from that, I'm getting used to the new look IDL (after the
initial "Why's it so darn bubbly an WinXP-esque?" shock...) and even
this new workspace malarky isn't all that bad (I simply chucked my
entire IDL programmes directory into \workspace\default and kept my
own tree structure intact. Crude, but it works for me!)

I really like the 'fast tab' option, too. Now all I have in the window
(á la Doug's idea) are the editor, command line and console. Even
variable watch is consigned to the fast tab - though it never stays
there for any length of time, as a rule.

Thanks to everyone for all the discussion since the new release, and
particularly to the guys from ITTVIS who've taken the time to keep an
eye on the newgroup and reply to the various queries!

Chris
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Subject: Re: IDL 7.0 Projects
Posted by Spon on Thu, 06 Dec 2007 13:24:40 GMT
View Forum Message <> Reply to Message

Oh, one more thing - is there a way to have multiple helpfile tabs
open? That's a REALLY useful feature :-)

Chris

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Thu, 06 Dec 2007 14:05:29 GMT
View Forum Message <> Reply to Message

Spon writes:

>  Oh, one more thing - is there a way to have multiple helpfile tabs
>  open? That's a REALLY useful feature :-)

Gosh, I hadn't even gotten around to trying HELP yet.
I just started her up. You are right, it takes a LONG
time to get going. Mine didn't exactly finish though.
Quit with a java.lang.OutOfMemoryError. Oh well, my
expectations were low anyway. :-(

Cheers,

David
-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Thu, 06 Dec 2007 14:46:29 GMT
View Forum Message <> Reply to Message

David Fanning writes:

>  Gosh, I hadn't even gotten around to trying HELP yet.
>  I just started her up. You are right, it takes a LONG
>  time to get going. Mine didn't exactly finish though.
>  Quit with a java.lang.OutOfMemoryError. Oh well, my
>  expectations were low anyway. :-(

I'm getting tired of being a pessimist, but after
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closing all my other windows, except for the IDL Workbench,
I managed to get the IDL Help working. So, the first thing
I looked at was the What's New in IDL 7.0. (Just looking
for some good news, really.) I see there is a new 
routine Routine_Filepath. So I tried to look that up
in the Index. Nada. I mean, just nada. 

If I click the link in the What's New section I get
an HTTP error that it couldn't find the right file.

I'm discouraged.

Cheers,

David
-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: IDL 7.0 Projects
Posted by Vince Hradil on Thu, 06 Dec 2007 15:21:57 GMT
View Forum Message <> Reply to Message

On Dec 6, 8:46 am, David Fanning <n...@dfanning.com> wrote:
>  David Fanning writes:
>>  Gosh, I hadn't even gotten around to trying HELP yet.
>>  I just started her up. You are right, it takes a LONG
>>  time to get going. Mine didn't exactly finish though.
>>  Quit with a java.lang.OutOfMemoryError. Oh well, my
>>  expectations were low anyway. :-(
> 
>  I'm getting tired of being a pessimist, but after
>  closing all my other windows, except for the IDL Workbench,
>  I managed to get the IDL Help working. So, the first thing
>  I looked at was the What's New in IDL 7.0. (Just looking
>  for some good news, really.) I see there is a new
>  routine Routine_Filepath. So I tried to look that up
>  in the Index. Nada. I mean, just nada.
> 
>  If I click the link in the What's New section I get
>  an HTTP error that it couldn't find the right file.
> 
>  I'm discouraged.
> 
>  Cheers,
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> 
>  David
>  --
>  David Fanning, Ph.D.
>  Fanning Software Consulting, Inc.
>  Coyote's Guide to IDL Programming:http://www.dfanning.com/
>  Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Hmmm. Works for me.  Could be an install problem.  Also, the help
seems to use jsp, Problem(?)

For those who find the help slow, have you tried "Dynamic Help"?
Either "Help->Dynamic Help" or "Window->Show View->Other...:Help
+Help".  Is this faster for you?  You can have it open all the time if
you want - or make it "fast view"

Subject: Re: IDL 7.0 Projects
Posted by ronn on Thu, 06 Dec 2007 15:34:18 GMT
View Forum Message <> Reply to Message

On Dec 6, 8:24 am, Spon <christoph.b...@gmail.com> wrote:
>  Oh, one more thing - is there a way to have multiple helpfile tabs
>  open? That's a REALLY useful feature :-)
> 
>  Chris

Well, I have found a way to have two help windows open.

First type ? at the command line and the help will show up as part of
the workbench.  Click and drag this off the workbench so that it
becomes a detached view.  Now go to Help->Help Contents.  Now you have
two help windows open!

-Ronn Kling

KRS, inc.
email: r...@rlkling.com
Use these books to upgrade your IDL skills.
"Application Development with IDL"
"Calling C from IDL, Using DLM's to extend your IDL code". SECOND
EDITION includes C++ and debugging! THIRD EDITION includes writing IDL
object methods in C and C++!
"Power Graphics with IDL, A Beginner's Guide to Object Graphics"
"IDL primer"  A concise introduction to IDL
"Navigating the IDL workbench" Working with the new IDL 7.0

http://www.kilvarock.com
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Subject: Re: IDL 7.0 Projects
Posted by Spon on Thu, 06 Dec 2007 16:19:13 GMT
View Forum Message <> Reply to Message

>  Well, I have found a way to have two help windows open.
> 
>  First type ? at the command line and the help will show up as part of
>  the workbench.  Click and drag this off the workbench so that it
>  becomes a detached view.  Now go to Help->Help Contents.  Now you have
>  two help windows open!
> 
>  -Ronn Kling

This works very nicely, thank you. It seems to be limited to two,
whereas before you could have endless numbers of tabs open, but it
does help.

For the record, 'dynamic help' is substantially quicker than 'help' on
my windows machine, and now resides in my Fast View where 'help' once
sat. My beloved index is now only a click away. Thanks for this tip,
Vince!

Chris

Subject: Re: IDL 7.0 Projects
Posted by Paul Van Delst[1] on Thu, 06 Dec 2007 16:45:44 GMT
View Forum Message <> Reply to Message

David Fanning wrote:
>  Paul van Delst writes:
>  
>>  p.s. still waiting for a 7.0 install.....
>  
>  Well, then you still haven't seen how glowing the future
>  looks. Maybe you will change your tone to one of respectful
>  awe when you do. :-)

Oh, I am quite sure my jaw will drop in awe.... but I posit the emotional adjective will 
be different than you think. :o)  I have used eclipse in the past and the year or so since 
then hasn't diminished my underwhelm-ment.

I cherish my learning curves and can't waste 'em. :o)

cheers,

paulv
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Subject: Re: IDL 7.0 Projects
Posted by David Fanning on Fri, 07 Dec 2007 14:28:00 GMT
View Forum Message <> Reply to Message

Paul van Delst writes:

>  Oh, I am quite sure my jaw will drop in awe.... but I posit the emotional adjective will 
>  be different than you think. :o)  I have used eclipse in the past and the year or so since 
>  then hasn't diminished my underwhelm-ment.
>  
>  I cherish my learning curves and can't waste 'em. :o)

Well, I've finally given up on the laptop. There it is going
to have to be IDL 6.4 or IDL 7.0 and EMACS. The Workshop is
just not going to run on 512 MByte of RAM, and that is that.
I've been wanting a new laptop anyway.

So, I decided to have a look at this on my new beefed up
office computer, where I have some room, RAM, and resolution.
My impressions of IDL 7.0 are decidedly more favorable than
they were yesterday. So, this is on Windows XP, 4 MByte RAM.

I was *extremely* concerned about some of the things I read
yesterday about On-Line Help. I'm VERY happy to report that
none of them are true for me. I usually make a short-cut to
IDL on-line help so I can run it in as a separate application
on my 2nd monitor. Absolutely no problem doing that, and I
can still access Help, or Dynamic Help, from the Workspace.
It appears I can have as many Help windows open as I care to.
All of this works *exactly* as it did in IDL 6.4.

Someone else mentioned problems with finding WIDGET_CONTROL.
I am happy to say when I typed this into the index of either 
the Help or the Dynamic Help I was taken immediately to what
I expected. I cannot account for the reports yesterday.

I like the Fast View functionality, but I have one quibble.
Could the view please remember the last page size, so that
when I call it up again, it is the same size it was the last
time I accessed it? Especially with On-Line Help, it always
comes up in a narrow, skinny window, that I have to resize to
see anything. The Workshop seems to remember the rest of my
mistakes, so it is probably trivial to make it remember something
I really want. :-)

Of course, I haven't got my projects set up here yet. I'll
probably just chuck everything into the Default project like
everyone else and be done with it. (I'm joking.)
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Anyway, if you have enough of a machine to handle this, you
come away with a better impression.

Cheers,

David
-- 
David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")
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